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President’s Page

Pride…and A Couple of Pleas for Help
Ken Goldman

Pride

If anyone would like to make a personal contribution to the

I began my second year as president of Washington Apple Pi

Scholarship’s endowment, here are two ways you can do it:

with a great deal of pride. Over the summer, the Pi Board of Di-

Online: give.gmu.edu

rectors worked with George Mason University to iron out the

Write in the “other” section: Washington Apple Pi Scholarship

final details for the Washington Apple Pi Scholarship at George

Fund, fill out the form and pay by credit card.

Mason University. On 1 September 2016 George Mason Uni-

Mail a check: GMU Foundation, 4400 University Drive, MS 1A3

versity issued a press release announcing the scholarship. The

Fairfax, Virginia 22030.

press release can be viewed at:

Checks should be made out to: GMU Foundation and the des-

https://volgenau.gmu.edu/news/255181

ignation, Washington Apple Pi Scholarship Fund.

As a community of Apple iPad, iPhone and Mac users, people

A Couple of Pleas for Help

with a common aim to improve knowledge and enjoyment of

Over the years, the Pi has undergone a lot of changes, perhaps

Macintosh computers and Apple mobile devices, the Pi’s philos-

the most significant of which has been the decreasing member-

ophy has always been one of “users helping users.” We should

ship. In September 2015, The New York Times published an ar-

all be proud that we are now extending this philosophy forward

ticle titled “Mac User Groups Fade in Number and Influence, but

for years to come by devoting some of our financial resources

Devotees Press On.”

to help students at George Mason University. Thank you all for

http://www.nytimes.com/2015/09/09/technology/personaltech/apple-mac-

your support in creating this scholarship, and a special thanks to

user-groups-devotees-press-on.html?_r=0

Larry Kerschberg and his late wife Nicole for conceiving the idea
and proposing the scholarship.

Reading this article was somewhat encouraging to me, as the Pi
is larger and more vital than most of the other groups around

Volume 38, No. 1



Contact Us



Contents



Full Screen Mode



Previous Next



Washington Apple Pi Journal

4

the country and the world. If you look back on the

the monthly meetings, and hand them out and post

one person, Jonathan Bernstein, working on this,

past year we have had some exceptional events,

them.

with input from the Board. It is a heavy load for just
one person. I would like to develop a Program Com-

such as our joint meeting with Asbury Methodist Village featuring Walt Mossberg, Jimmy (“JimmyMac”)

Now to plea number two: As you all know, the Pi

mittee with at least two other volunteers to work

Obomsawin’s talk about home automation and

is an all-volunteer organization, which currently de-

with Jonathan. If you are willing to help, please vol-

HomeKit, the Pi Photo Contest, and presentations on

pends on a small group of people to get all the work

unteer. Also, if you have any ideas for speakers or

what’s new at Apple from Aaron Davis.

done. Because of this, the bench is very thin (typi-

subjects, please share them, and then work with the

cally one person) for each function. As we all have

committee to make them happen.

I think that we can all agree that this is an exciting

lives, this means that some things do fall through

time for Apple products, but the world has changed.

the cracks. I would like to ask each of you to think

Help with some of the day-to-day admin details

Many users now view their Macs, iPhones and iPads

of how you can help support the Pi and jump in to

of the club. There are lots of things we do behind

as appliances. With the advent of Internet resources

help; if you feel we are falling short in some way,

the scenes, most of which are handled by the same

like YouTube and the Genius Bar at Apple stores, the

please help us to succeed in that area. Some things

small group of volunteers. If you can just take up

appeal of and perceived need for User Groups have

you can do include, but are not limited to:

one job from someone else it would help tremendously. Please send me your name and we will pro-

faded…but, I believe that they are more unknown

vide you with some options.

than irrelevant. We frequently have non-members

Write an article for The Journal. You don’t need to be

show up at a Clubhouse Saturday seeking help. Our

a tech expert; an amateur just relaying their experi-

members collaborate to solve their problem, making

ences can often write an article that is interesting

Thank you all for being Pi members. I look forward

them believers, and frequently new members.

and helpful to others.

to seeing all of you at upcoming meetings. As we
head into the holiday season, I wish you all Happy
Holidays and a Happy and Healthy New Year.

Volunteer to edit The Journal. Jay Castillo has been

all of you to jump on the bandwagon to help inform

doing this job for about five years now and is ready

the world that we are still here and they should

to hand the reins to someone new.



check us out. We have a new tri-fold pamphlet and
a flyer with www.wap.org tear-outs at the bottom.

Help to find speakers for our General Meetings and

I encourage all of you to pick up a few brochures at

Afternoon Learners SIG meetings. We currently have

Washington Apple Pi Journal
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Editor’s Page
Jay Castillo

H

ello, it’s been a while since I was here. As you are well aware,
the Journal issues have become intermittent. When I became
the Journal managing editor in 2011, we were publishing six

issues per year. Now we are struggling to publish two issues per year. In
previous issues I have urged members to contribute articles for publication
on any subject pertaining to Apple products or digital life in general. A few
stalwart folks have responded, but too few, and too slowly. In January 2010,
we had 803 Pi members; today we have 358 members, so, the pool of potential contributors has decreased significantly.
I am very proud of the quality journals we have published over the years,
relying on the membership for content. But we now face the daunting
question of how we continue the publication of the Pi Journal. Is it to become an annual publication? Does it remain simply sporadic? Do we go
to some other type of publication? Please let me or any member of the Pi
Board of Directors hear from you, the members. We welcome ideas for the
future of the Journal. Meanwhile, enjoy this one.

Volume 38, No. 1
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When Bad Things Happen to Good Macs
Jay Castillo

What had
happened to my
iMac, and what
could I now do to
ensure my system
wasn’t corrupted
and to keep it
from happening
again?

The Problem

W” to close the window: Nada! Then I did the same for Safari:

I was enjoying my daily perusal of Internet sites, using Safari,

Bupkes! I then did the Force Quit routine for Safari: No re-

when a pop-up message appeared. Unfortunately, I didn’t cap-

sponse! Safari was locked tight, and I was stuck.

ture an image of it, but it said something like,
You have a problem with your system. If you quit your

Next, I restarted the system. It booted up again, but when Safari

browser or shut down your system, you will damage your

started up, there was the pesky pop-up window, just as before

hard drive or lose data. Click here to get help.

I rebooted. Unfortunately, I had set Safari preferences to “open

The only available button in the pop-up window was “O.K.” The

with all windows from last session”, (see Figure 1) and that’s

pop-up window appeared to be consistent with OSX formats,

what I got. I gritted my teeth, disconnected from the Internet,

but I was immediately highly suspicious. So I hit “Command-

hoping nothing nefarious could be downloaded if it wasn’t
there already, and clicked ”O.K.” Up came a second pop-up, with
a phone number to call and with an advertisement for repair
of my Mac, but nothing to click. I was then able to close all windows. What had happened to my iMac, and what could I now
do to ensure my system wasn’t corrupted and to keep it from
happening again?
I was the victim of malware. Wikipedia defines malware as,
Malware, short for malicious software, is any software
used to disrupt computer operations, gather sensitive
information, gain access to private computer systems, or
display unwanted advertising. Malware is defined by its

Figure 1: Safari Preferences-Safari
Opens With…

Volume 38, No. 1
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malicious intent, acting against the requirements of the

7

Figure 2: Malwarebytes main window

Figure 3: Malwarebytes scan results

Figure 4: Malwarebytes Scan declares “All Clear”

computer user, and does not include software

pany website:

Steps” to learn about what can be done to combat

that causes unintentional harm due to some

(https://www.Malwarebytes.org/antimalware/mac/) and

malware and prevent being victimized. There is

deficiency.

downloaded the application. Figure 2 shows the

a specific page for scam pop-ups and what to do

Malware is a persistent threat to any computer

application window when opened. The interface

about them

user, and Macs are being subjected to it more and

is simple, and clicking on “Scan” starts the process.

(http://www.thesafemac.com/tech-support-scam-pop-ups/).

more. Security through obscurity is no longer true, if

The scan of the system was quickly done and found

I also changed my Safari Preferences to Safari

it ever was.

several pieces of malware, which were removed (see

“Opens with a new window” from the drop down

Figure 3). Clicking on “Scan” again provided the all-

menu shown in Figure 1.

The Solution

clear message shown in Figure 4. Note that there are

Fortunately for me, a few days earlier at the Pi

additional steps you can take if the problem persists:

I noticed that the scam pop-up page provided by

Clubhouse Saturday session, one of my sainted col-

You can click on “What to do if your problem was

the above link declared,

leagues had shown me a free-for-Macs anti-malware

not solved,” or click on “ Next Steps” in the applica-

It is also important to understand that these

application, called, Malwarebytes. I went to the com-

tion main window. I recommend going to “Next

messages are not caused by a virus, or any

Volume 38, No. 1
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Figure 5: I encountered another pop-up window.
Figure 7: Bitdefender App main window

other kind of malware. Many people’s first
reaction to a pop-up like this is to go download anti-virus software. This is the wrong
response, as there is no malware involved,

being displayed by the current page.) At most,
web browsers can warn you that a particular

Figure 6: Yet another example of nefarious pop-ups.

and thus the anti-virus software will not solve

site you are trying to visit is bad, but they

the problem.

cannot make any determinations as to the

I suppose that Malwarebytes does not define JavaS-

while the other appears to be related to my Internet

cript pop-ups, as these are, to be malware. They

provider. To the uninitiated, these messages might

seem to distinguish them as “adware.”

appear worrisome and require the directed actions.

This experience prompted me to rethink my

However, the Malwarebytes support pages declare:

approach to anti-virus software. I have been using

state of your computer.

As I was responding to the changes to the draft of

It is important to understand that no website

the free application, Virus Barrier Express, which

this article, made by one of our esteemed editors,

can scan your computer for malware or

has consistently declared my iMac to be virus-free.

another pop-up appeared in Safari. This time I

suspicious activity. Further, Mac OS X will

My sainted colleague had also recommended

was able to grab a screenshot, shown in Figure 5.

never display such a message within your web

Bitdefender Anti-Virus for Mac. I went to the website

Fortunately, force-quitting Safari got rid of it, since I

browser. (If you are unsure as to whether the

(http://www.bitdefender.com/solutions/antivirus-for-mac.

couldn’t close any browser windows. Figure 6 shows

alert is being shown by your browser or by

html) and downloaded the free 30-day trial version.

another example that I encountered. Note that one

the system, try hiding the browser by pressing

Figure 7 shows the application window. The

message appears to be from a Mac support website,

command-H. If the message hides as well, it’s

interface is simple and understandable. When I ran

Volume 38, No. 1
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Figure 9: Bitdefender declares, “Your Mac is Safe.”

Figure 8: Bitdefender scan results
Bitdefender, I got the result shown in Figure 8. I clicked on “Delete manually,”

is $59.95. The subscription can be for two or three years with a corresponding

ran it again, and the result is shown in Figure 9. So this app found a virus that

increase in price. I think I’ll shop around; there are some decent free apps,

my previously used app did not. Scary! A useful feature of Bitdefender is that it

such as Avira. But I now have a better and more serious appreciation of the

automatically updates itself in the background, and provides a notification when

threats to which the Internet exposes us, and I think I need to be more careful

it does so.

and certainly more proactive. And I highly recommend attendance at the
Pi Clubhouse Saturdays.



cough-up $39.95 for a one-year subscription. A subscription for up to 3 Macs

Washington Apple Pi Journal
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What’s New From Apple
Brent Malcolm

A

pple has recently released the newest versions of

to developers, which should result in sweeping enhancements

their operating systems. They are now available for

of current and future third-party iOS apps. For example, you’ll

download, and here is an overview of what to ex-

be able to use Siri to call a car with Uber or Lyft. Typing suggestions will be improved, Photos will be enhanced, and Maps will

pect from them.

gain more capabilities. Lastly, the Music app is redesigned and

MacOS and iOS

HomeKit is improved.

MacOS Sierra adds support for Siri, enhances Photos with
automatic recognition technologies, and enables Apple Pay for

watchOS and tvOS

the Web so you can use Apple Pay for things ordered online

The biggest watchOS improvement is faster apps launching.

with Safari. To integrate the Mac more deeply into Apple’s

Additionally, there are more watch faces and simplified mes-

ecosystem, you’ll be able to auto-unlock your Mac when you’re

sage reply. The side button now displays the Dock, which you

wearing an Apple Watch, copy and paste between your Mac

can configure with your most-used apps, and swiping up from

and your iOS devices, and access everything in your Desktop

the bottom of the screen shows Control Center. Pressing and

and Documents folders on any iOS device via iCloud Drive.

holding on the side button brings up an SOS screen for mak-

Minor changes add tab support to all apps and add picture-in-

ing an emergency call. Apple has improved the popular Timer

picture support in case you ever wanted to watch a video while

app, and the Activity app now offers activity sharing and gains

you’re doing other tasks.

awareness of the activity of wheelchair users. A new app called
Breathe helps users relax with deep-breathing exercises.

The changes to iOS are even more far-reaching. The lock screen

Volume 38, No. 1

Finally, tvOS 10 enhances its support for Siri; for instance, you

and the camera. 3-D touch allows notifications to display ap-

can use Siri to find a particular YouTube video or a particular

plication data without unlocking. For instance, you can press an

sporting event. Instead of requiring a sign-on for every cable

iMessage notification to see the conversation. Siri will be opened

or satellite connection, Single Sign-on simplifies login to apps
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that require cable or satellite subscriptions. A new “dark mode”
is added for those who find the brightness of the interface visually painful. A new iOS Remote app will do everything the Siri
Remote can, including work with Siri, navigate the interface, and
act as a game controller. Finally, if you get an iOS app with an
Apple TV version, it will download automatically, saving you a
search in the Apple TV App Store.

Am I Compatible?
It’s all well and good to swoon over the new software, but will
my Mac/iPhone/iPad run the new offerings? Here’s the list of
compatible hardware for macOS Sierra: MacBook (Late 2009 and
later); iMac (Late 2009 and later); MacBook Air (2010 and later);
MacBook Pro (2010 and later); Mac mini (2010 and later); Mac
Pro (2010 and later); iPhone 6s; iPhone 6sPlus; iPhone 6; iPhone
SE; iPhone 5s; iPhone 5c; iPhone 5; iPad Pro 12.9 inch; iPad Pro
9.7 inch; iPad Air2; iPad Air; iPad 4th generation; iPad Mini4; iPad
Mini3; iPod Touch 6th generation. Please note that this is a preliminary list and it may change.
So, download these software updates and look forward to enjoying all these improved user capabilities. And, in Apple’s usual
grand design, they’re all free!

Volume 38, No. 1
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Customizing the Finder Window
Neil McNamara

Figure 1: Systems Preferences window.

Figure 2: Application Preferences window.

Figure 3: Finder Preferences window.

ne of the truly great things about a Mac

System Preferences are settings that affect how

default template for all new contact cards that you

is that you can customize it extensively to

some aspect of your Mac works, no matter which

create, and decide how to sort your contacts, and

look and feel just the way you want it to.

application(s) you are currently running (Figure 1).

whether to display last names first. You can find

There are several ways to do this, beginning by ad-

They allow you to control things like the way your

these preferences by clicking on the name of the ap-

justing preference settings. Your Mac has two types

mouse or trackpad work, or change the Desktop

plication in the Menu Bar as shown in Figure 2.

of preferences: System Preferences and application

Background picture, or pick a screen saver, etc.

O

Perhaps the most overlooked set of application pref-

preferences. When you get your Mac, Apple has set
all of these preferences to certain default values, but

In addition to System Preferences, there are also

erences are the ones that control the Finder window,

you will almost certainly want to make changes from

preferences for every application on your Mac. For

but they are also among the most useful. As with

those factory settings.

example, you can set your home page in Safari to

other applications, you reach them by clicking the

allow or block cookies; in Contacts, you can set the

application name (Finder) in the Menu Bar and then

Volume 38, No. 1
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Figure 6:To customize Finder window toolbar.

Figure 4: Default settings for Finder Window

under Favorites, but that’s not the only way to de-

Figure 5: Finder Sidebar Tab window.

termine what appears there. You can also drag and

selecting Preferences. When you do, you’ll see a

folder on your computer; when you find it, just click

drop any folder into the sidebar from the main panel

panel with four tabs along the top. On the General

Choose.

of any Finder window. Furthermore, you can rearrange them in the Favorites section just by dragging

tab shown in Figure 3, you can choose which type of

them up or down.

devices to display on your Desktop and — more im-

Another useful Finder preference setting is on the

portantly — what folder you want to see when you

Sidebar tab of Finder’s preferences. By default, cer-

open a new Finder window. By default, new Finder

tain items are shown in the Favorites section of the

But wait, there’s still more! In addition to custom-

windows open to All My Files as shown in Figure 4.

sidebar, but they don’t include the user’s home

izing the Finder Preferences, you can also customize

Perhaps, though, you would find it more helpful to

folder; note that there is no checkmark next to it in

the toolbar in the Finder window to add or remove

have Finder windows open to your home folder or

the screen shot in Figure 5. But if you want the side-

tools as you see fit. All you have to do is right-click

your Documents folder. All you have to do is click on

bar to include a shortcut to your home folder — the

in an empty spot in the Finder toolbar as shown in

the dropdown menu and select any folder you like.

folder where your entire user content is stored —

Figure 6 and select Customize Toolbar. You can also

If you don’t see the folder you’re looking for, just

you only need to check the box next to it. In fact,

find that selection on the Finder View menu. When

click on Other… and you’ll be able to browse to any

you can check or uncheck all of the items listed

you do, you’ll see a display something like Figure 7.

Volume 38, No. 1
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Figure 7: Select “Customize Toolbar” from the View menu.
You can now drag and drop any of the tool icons
you see into the Finder window’s toolbar. I like to
install the New Folder and Delete icons in the tool-

Figure 8: Select “Show Path Bar.”

Figure 9: Home Folder in the Finder window.

bar, but there’s one other useful item in this dialog

out to be especially helpful. My personal favorite is

the standard set of folders that OS X creates for each

box. Look in the lower left corner and you’ll see a

Show Path Bar (Figure 8). Choose this selection and

user account. Personally, I get eyestrain trying to see

dropdown menu that currently says Icon Only. The

every time you open a Finder window, you’ll see the

those little icons. Luckily, you can make them much

other choices on the menu are Icon and Text and

full path from your Macintosh HD down to your cur-

easier to see by clicking on the View menu and then

Text Only; I prefer Icon and Text; that will put text

rent file or folder displayed horizontally across the

selecting Show View Options near the bottom of

labels beneath each of the tool icons in the toolbar.

bottom edge of the window. That information often

the View menu. When you do, you’ll get a popout

After you’ve finished customizing the toolbar, click

comes in handy.

dialog box something like the one in Figure 10. Bear
in mind, though, that the contents of this dialog box

the blue Done button in the lower right corner of
the dialog box. If you ever decide you want to revert

There are many more ways to customize the layout

change depending on whether your Finder window

to the original set of icons in the toolbar, open this

of the Finder window, but the last one I’ll mention

is currently set to the Icon view, the List view, the

dialog box again, drag the default setup into the

here is called Show View Options. As the name sug-

Column view or the Cover Flow view in the toolbar

toolbar and then let go.

gests, you’ll find it on the View menu in Finder. It’s

at the top of the window. In the example shown

particularly helpful to those of us “of a certain age.”

here, I’ve selected the List view.

At this point, it may seem as though you’ve explored

Look at the folder icons displayed in Figure 9. I’ve

all of your options, but guess what? There are still

selected the home folder in the sidebar of the Finder

As you can see, there are lots of check boxes that

some choices on the Finder View menu that turn

window and the main viewing area is now showing

allow you to decide which columns you would like

Volume 38, No. 1
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Figure 7: Select “Customize Toolbar” from the
View menu.

Figure 11: Default Finder window layout.

Figure 12: Customized Finder window layout.

to see displayed whenever you open a Finder win-

Finally, I would draw your attention to the Icon size

see a Finder window as it looks with the factory de-

dow. Their names are all fairly self-explanatory. You

and Text size options near the top of the dialog

fault settings. On the right, we see Joe’s customized

can experiment with them and decide for yourself

box. There are only two icon sizes, but for me the

window with larger, more readable icons and fonts,

which ones you consider most useful. The only one I

larger size is a Godsend; it’s just so much easier to

Joe’s home folder displayed in the sidebar, the full

would single out is Calculate All Sizes. By default, the

see. I also like to bump up the text size from the de-

path displayed in the Path Bar along the bottom of

Finder window only displays the size (in Kilobytes,

fault value of 12-point to the much more readable

the window, the New Folder and Delete icons in the

Megabytes, Gigabytes, etc.) of files — not folders.

14-point.

toolbar, which also has text labels beneath all of the
icons, and the sizes of all of the folders listed in the

So if you want to know how much space one of your
folders or subfolders is taking up on your hard drive,

Putting it all together, after using all of the methods

main viewer pane. I find the customized version to

you won’t see it; instead you’ll just see a couple of

described in this article, a hypothetical user named

be both more readable and also much more useful

hyphens in the Size column of the display. However,

Joe Apple Pi has a very different Finder window lay-

than the way it came from the factory.

if you check the Calculate all sizes box, Finder will

out than the original factory version that came with

display the size of all folders. I can’t think of any rea-

his new Mac. Shown below are Joe’s “before” (Figure

All that and we never even talked about customizing

son not to check that box.

11) and “after” (Figure 12) layouts. On the left we

the Tags shown in the Finder window sidebar…

Volume 38, No. 1
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Fergy’s Ordeal With His External Hard Drive
Containing Very Important Stuff
Neil Ferguson

L

ong ago, Fergy bought an external hard
drive to use for Time Machine backups. He
had never done a restore from his Time

Machine and didn’t know how to do this if it became
necessary some day.
As time went on, he pretty much filled up his Mac’s
internal hard drive and, rather than weed out unnecessary stuff, bought a new external hard drive
and began shifting data from his internal hard drive
to his external hard drive. Over a period of time this

Figure 1.

new external hard drive began accumulating important stuff like pictures, movies, music and many

traught. Once again, Fergy bought a brand new

not his problem. Fergy’s problem was how to restore

other things. Fergy did not want to lose anything on

external hard drive. Since Time Machine was back-

the external hard drive’s data that was backed up in

this new external hard drive, so he used Time Ma-

ing up two hard drives, the Mac’s internal hard drive

Time Machine to his brand new external hard drive

chine’s option of also backing up his new external

and the external hard drive, he did not know how

that was replacing the dead external hard drive.

hard drive along with his internal hard drive.

to retrieve the data of the external hard drive from
Well, Fergy did what we all do: he turned to Google,

Time Machine.

‘as Google knows everything.’ Google showed

For many years Fergy did not have any problems.
But one day his new external hard drive that had

Fergy knew how to do a Time Machine Restore that

Fergy many websites of articles on how to solve his

lots and lots of his important stuff on it died, never

would restore the backed-up Mac’s internal hard

problem. With all the various solutions that Google

to be resurrected. Needless to say, he was very dis-

drive into his Mac’s internal hard drive but that was

presented, he was completely confused—which
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Figure 4.
Figure 2.

is pretty much Fergy’s state of mind anyway. One

Figure 3.

thing that was presented by the many websites

revealing the contents of his Time Machine. What

drives that Time Machine backs up including his de-

was that the brand new hard drive should have the

Fergy saw was a Finder window showing a folder

funct external Seagate drive as shown in (Figure 5).

same name as the dead external hard drive had in

with the name “Backups.backupdb” (Figure 2). He

Fergy double clicked on the name of his external

Time Machine. That was the only thing that Fergy

then clicked on that Backups.backupdb folder icon,

Seagate hard drive and was happy to see that all his

remembered out of all this searching. He was still in

revealing a folder with the name of his computer, as

files and folders were actually in his Time Machine

a dilemma as to what to do to get the data out of

shown in (Figure 3).

backup (Figure 6).

Fergy clicked on the folder with the name of his

Now, the question was how to get the data out of

Fergy had his computer set up so that all his hard

hard drive and upon opening it he saw a list of all

Time Machine and into his new external hard drive.

drive icons were always present on his desktop.

the times that Time Machine performed a backup.

He did a lot of searching but couldn’t find any

So, Fergy doubled clicked on his Time Machine icon

(Figure 4) shows the most recent backups. He picked

references about how to do a restore of the contents

that was displayed on his desktop (right under his

the last time that a backup was performed where his

of his backed up external hard drive to the new

Macintosh HD icon) as shown in Figure 1. He double

external Seagate hard drive was still functioning.

external hard drive. Fergy decided to take a trip to

clicked on this Time Machine icon and it opened up

A window opened up showing a list of all hard

the Apple Store and ask them.

Time Machine.
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Figure 5.

Figure 6.

Ah-Ha! The Apple Store had a solution. The solution

the dead external hard drive was necessary or not,

deed he sat down and cried. But…he remembered

is to open Time Machine by clicking on the Time Ma-

but it did work.

how he recently recovered all the data from Time
Machine that came from his external hard drive, so

chine icon on the desktop; navigate down to where

he applied his recently acquired knowledge to put

played; perform a Select All (CMD+A), which high-

A sequel that utilized
the experience above

lights all of the folders and files. And then of course

One day Fergy was formatting thumb drives to the

hard drive.

drag the selection onto the icon of the new external

EXFAT format so the thumb drives would hold files

hard drive that is displayed on the desktop, and re-

larger than 4 GB in size. Somehow, unbeknownst to

lease the mouse button.

Fergy, he inadvertently replaced the name of his ex-

the content of the dead external hard drive is dis-

his external hard drive data back on his external

And Fergy lived happily ever after…

ternal hard drive with the name of one of the thumb
drives. Yes, when he thought he was formatting his

just had to write this story. Fergy doesn’t know if the

thumb drive he was actually formatting his exter-

naming of the new external hard drive the same as

nal hard drive. When Fergy discovered his dastardly

Washington Apple Pi Journal
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Wow!! My iDevice does that?
Ron Masi

W

ow!! My iDevice does that? Have you

screen with two fingers. Yes, if you have an iBook on

wondered why your iPhone, iPad,

the screen, it will read it to you. You can even choose

or iPod won’t do X, Y and Z? Well, in

the language from this settings screen. This action is

many cases it will do X, Y and Z, but we just don’t

useful if the page is in several languages; it will read

• If you like falling asleep listening to
your iDevice playing/reading etc. but
don’t want it playing all night, here is
how to set the timer:

know how to tell it to. Below, we’ll start sharing “hid-

them in the language written. To control the speed

On the bottom pull-up screen, select the Clock icon,

den” features and finding out what we are missing.

while content is being read, a box appears on screen

and then in the lower right corner select the Timer.

After reading this article and following the steps,

showing an icon of a rabbit and a turtle, allowing

Now set the amount of time you want the device to

you’ll be able immediately to find all your draft

you to speed up, slow down or stop. If the page

play. Note: just this next step differs slightly by de-

email, and make the device read the screen to you

cannot be read, you’ll receive a written and spoken

vice.

and stop speaking/playing music after you go to

notice something like, “No speakable content could

sleep. You can do all this with nothing to buy or

be found on the screen.” Give it a try.

On the iPad tap the music icon between the Pause

download, since your updated device already has

and Start buttons.

• Can I make my device read
the screen to me?

• Want to find all your draft
emails quickly (emails that have
been started but not finished or
sent) with just one touch?

Yes, you can and fairly easily. Go to the Settings

Easily done by opening Mail and holding down the

This action opens the When Timer Ends window.

Menu, choose General, then > Accessibility >

Compose icon for a second (it looks like a box/piece of

Scroll down and select the last option, Stop Playing.

Speech. From there, all you have to do is turn on

paper with a pen on it). Immediately a drop-down box

Then tap “Set” in the top right of the window. Now

“Speak Selection.” Now, anytime you choose a text

with all your drafts is displayed; just tap the one you

when the time you set is up (and hopefully you are

selection, your phone will read it to you. If you select

want. In addition, when you quickly tap the Compose

fast asleep), your device stops playing and goes to

“Speak Screen” the screen contents are read to you

icon you’re presented with a blank new message page

sleep with you.

when you swipe down from the very top of the

ready for you to address and type your email.

Washington Apple Pi Journal
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Hot Links

Hot Links
• Wait! Is my Mac looking at me? Worried about your webcam being hijacked?
http://mac360.com/2016/10/is-your-macs-camera-spying-on-you/

• My 500 GB Time Machine drive doesn’t cut it anymore. Transfer your backups to a new larger drive and press on.
http://www.macworld.com/article/3125097/macs/how-to-transfer-a-time-machine-backup-to-another-backup-drive.html?idg_eid=5d139d8d7ead280e99465
07f471d520a&token=%23tk.MCW_nlt_mw_macweek_html_2016-10-05&utm_source=Sailthru&utm_medium=email&utm_campaign=MacWe

• Forget your reading glasses? Use the iPhone, Luke.
https://www.macobserver.com/tips/how-to/iphone-magnifying-lens/

• Startup key combinations are quite useful.
http://tidbits.com/article/16712

• Produce your own Karaoke scene with your iTunes app.
http://www.idownloadblog.com/2016/09/23/view-song-lyrics-in-apple-music-on-mac/

• Hey Siri! Here’s a useful menu of Siri queries:
https://hey-siri.io
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The Power of Preview:
Converting Images and Exporting PDFs
Josh Centers and Adam C. Engst
In our exploration of Preview, OS X’s built-in image and PDF powerhouse, we’ve

PDF out of Preview. Oddly, the Export as PDF dialog lacks the Quartz filter and

walked you through getting files into Preview (see “The Power of Preview: Pulling Files

encryption options that the regular Export command does, and all the other

into Preview [1],” 25 February 2016) all the way to advanced editing techniques

options available with the next command.

(see “The Power of Preview: Advanced Editing Techniques [2],” 25 April 2016). As our series

•

Print: You may not realize this, but in OS X, you can “print” anything to a PDF!

draws to a close, it’s time to end it in the natural place: saving and exporting your

More on this in a bit, but for now, just know that using the Print dialog to ex-

files.

port a PDF offers some advantages.

Since Preview uses the Modern Document Model (see “The Very Model of a Modern

There’s also a fourth option, Save As, which doesn’t appear by default. Hold

Mountain Lion Document [3],” 7 August 2012), it saves existing files automatically as

down the Option key to change the Duplicate command to Save As. But with

you edit. Likewise, Preview supports Resume, so if you quit Preview without sav-

one minor exception that we’ll cover later, Save As does the same thing as

ing, or Preview closes due to a crash or power outage, you won’t lose your work.

Export, so there’s no need to bother, unless you’re just working out of habit. If
you prefer Save As to Duplicate, check out “Put Save As Back on the File Menu [4]”

But that’s all Mac 101. More interesting is how Preview can convert your files into

(30 November 2015).

different formats. You can even export a PDF as an image or vice versa! That can
be handy if, for instance, you have a one-page PDF flyer that you want to convert

Converting Image Formats — We assume that you understand the basics of

to a PNG or JPEG so it can be posted more easily on Facebook.

naming, saving, and tagging files, so we’ll focus on the interesting bit: format
selection. The Export dialog’s Format pop-up menu shows only 6 file formats by

Three commands in Preview’s File menu help you export your files:

default, but if you Option-click it, Preview displays 19 choices!

•

Export: This command enables you to save a copy of your file with a different

This conversion capability is handy, because if you have a JPEG and need a PNG,

name, in a different location, and even in a different format.

all you have to do is open the JPEG in Preview, choose File > Export, change the

Export as PDF: As you’d expect, this command is mostly a faster way to get a

Format pop-up menu to PNG (note the resulting file size estimate), and click

Washington Apple Pi Journal
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Save. But if you don’t already know that you need a PNG, which format should
you pick? It depends on your intended destination for the file. We’ll look at PDF
next, but the four most common image formats are:
GIF [5]: An ancient format, first introduced by CompuServe in 1987, the GIF image format has been superseded by PNG in every way but one: GIF supports a
flipbook-style animation, which is a topic for another article. Don’t use GIF unless
you want to create an animation, or just feel like reliving the battle over how it’s pronounced [6].
JPEG [7]: JPEG is great for photographs, and any image-viewing app can open JPEG
images. When exporting as JPEG, you can reduce the quality to reduce the file
size, which is useful for Web publishing. However, be aware that JPEG’s compression is lossy, which means data is actually thrown away during saves and can’t be
recovered. Because of this, every time you edit and save a JPEG, the picture quality will degrade a little. Don’t confuse JPEG with the JPEG-2000 [8] format. Despite
having a similar name and coming from the same group, they’re entirely different.
In theory, JPEG-2000 is better, but in reality, it doesn’t offer many benefits.
Figure 1.
PNG [9]: Conceived as an improved, non-patented replacement for GIF, PNG is

the choice for animations. Because of its lossless compression, photos saved in

designed for Internet image sharing, as opposed to professional-quality printing

PNG format have much larger files than those saved in JPEG format. By default,

(it doesn’t support non-RGB color spaces like CMYK). PNG uses lossless compres-

OS X creates screenshots in PNG format, though that can be changed with a

sion, making it ideal for images that you need to edit repeatedly, and it excels

defaults write command if necessary. (iOS screenshots are also saved in PNG for-

with computer-generated images that have large, uniformly colored areas, like

mat.) Be careful using JPEG for screenshots, or you may see artifacting in areas of

screenshots and logos. There are two variants of PNG that support animation —

solid color. In the example below (click it to zoom on our Web site!), the top im-

MNG and APNG — but support and usage are minimal at best, so GIF remains

age in PNG format is 1.4 MB, thanks to the photo background (Figure 1), whereas
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the bottom picture, saved at 50 percent quality in JPEG format, is only 152 KB.

nipulated independently, and layers can be turned on or off to try various edits

Notice that the photographic portion is nearly indistinguishable between the

without committing to them. Unfortunately, Preview doesn’t support layers at

two, whereas the solid blue in the book cover shows artifacting, particularly near

all, so while it can open a TIFF that contains layers, it “flattens” them into a single

the white text, in the JPEG image) When exporting a PNG from which you’ve re-

layer. The same goes for edits made in Preview; you can add a shape to a TIFF

moved the background with the Instant Alpha tool, as explained in “The Power of

and move it around while editing, but as soon as you close the image, the shape

Preview: Advanced Editing Techniques [11]” (25 April 2016), pay attention to the Export

is merged with the image layer.

dialog’s Alpha checkbox. This setting enables or disables transparency, which
sets a particular color as transparent, so the background color (of the Web page,

So, if you’re unsure, which format should you use? If the image is photographic,

say) shows through. If alpha is disabled, transparent portions of your image will

JPEG provides the best combination of quality and reduced file size. On the other

be rendered as white. It’s worth remembering that while PNG and GIF support

hand, if it’s a computer-generated graphic with large areas of uniform color, like

transparency, JPEG does not. So if you convert an image in one of those two for-

most screenshots, or if transparency is needed, stick with PNG. TIFF is useful pri-

mats to JPEG, whatever color has been declared as transparent (usually white)

marily in the print publishing world; for instance, a publisher may require that

may instead be rendered as another color. The code in the TidBITS Publishing

screenshots for a book be in TIFF rather than PNG for color workflow reasons.

System that makes thumbnails of graphics always creates JPEGs, which means

Also, use TIFF if you will need to edit with layers in an app like Photoshop.

that thumbnails of certain PNGs that contain transparency end up with black replacing the transparent portion of the image (at least until we notice and fix it).

What about all those other image formats? For the most part, they’re old, uncommon, or both, at least in the Mac world. The two exceptions are Photoshop

TIFF [12]: TIFF is another venerable format that has evolved over the years to be

and QuickTime Movie, which are plenty common, but unlikely to be useful within

extremely capable and useful, though today it’s mostly used in the print world.

Preview. Saving a file in Photoshop format does mean that Photoshop can open

TIFF files can be compressed, though that’s not required, and when saving one in

it natively, but as far as we can see, there’s no advantage over PNG in that regard.

Preview, you can choose from no compression, LZW compression, and Packbits

And we can’t figure out what file format you can open in Preview that you could

compression. The two compression choices are lossless, like PNG’s compression,

later save using QuickTime Movie; animated GIFs seemed the most likely, but

and LZW seems to result in a smaller file. Also like PNG, TIFF supports transpar-

they can’t be saved as QuickTime movies. If you’d like to read up on these other

ency, but what sets it apart is its support for layers. In graphics programs like

formats, here’s a full list, with informative links:

Photoshop and Pixelmator, layers enable you to work on the image as though

Washington Apple Pi Journal
Volume 38, No. 1



•

Contact Us

ASTC [13]



Contents



Full Screen Mode



Previous Next



you’re drawing on a transparent sheet of acetate. Objects on layers can be ma-

24

•

ICNS [14]

•

JPEG-2000 [15]

•

KTX [16]

•

Microsoft BMP [17]

•

Microsoft Icon [18]

•

OpenEXR [19]

•

PBM/PGM/PPM [20]

•

PVRTC [21]

•

Photoshop [22]

•

PostScript [23]

•

QuickTime Movie [24]

•

SGI [25]

•

TGA [26]

Figure 2.

with examples ranging from government forms to Take Control ebooks. But PDF
Despite the length of that list, there are many more graphic formats out there. If

is incredibly flexible — OS X’s Quartz rendering engine uses PDF internally, which

you run across a file that you can’t open, or if you need to save an image in a for-

is why it’s so easy to export things as PDF in OS X.

mat that Preview doesn’t support, turn to Lemke Software’s venerable
GraphicConverter [27], which can import approximately 200 file formats and export

Preview’s Export dialog provides two extra options when exporting PDFs: Quartz

in roughly 80 formats.

filters and encryption. Quartz filters modify the exported PDF in various ways, either adjusting the look of the document or tweaking its format under the hood.

Exporting to PDF: Quartz Filters — Entire books have been written about Porta-

In the first category, you’ll find Quartz filters for Black & White, Blue Tone, Gray

ble Document Format (like “PDF Hacks [28],” “PDF Explained [29],” and “Developing with

Tone, Lightness Decrease, Lightness Increase, and Sepia Tone. The tonal adjust-

PDF [30],” all from O’Reilly Media). Originally created by Adobe but an open ISO

ments do what you’d expect, making the image black-and-white or turning all

standard since 2008, PDF is one of the tech world’s most useful file formats. In

colors into shades of blue, gray, or sepia (Figure 2). The two lightness filters apply

the simplest terms, PDF represents the text and graphics of a printed document

to all colors as well, so their effects are relatively subtle in photos, but can make a

in digital form. The most common usage of PDF is in printing and publication,

large difference to colored text. (See Figure 3).

Volume 38, No. 1



Contact Us



Contents



Full Screen Mode



Previous Next



Washington Apple Pi Journal

25

Figure 3.

When it comes to fiddling with the document format, Apple provides Quartz
filters for Create Generic PDFX-3 Document and Reduce File Size. PDFX-3 is a
subset of PDF with printing-related requirements that facilitate a color-managed
workflow. Honestly, if you need a color-managed workflow, you should be (or
already are) using Adobe Acrobat Pro. Reduce File Size is alluring, but beware if
you have images other than photos in your document. When you use Reduce
File Size, Preview uses lossy compression to reduce the quality of every image in
the document, making non-photos notably fuzzy (Figure 4). Photos see a quality reduction too, but the effects are less noticeable. Happily, Reduce File Size
has improved radically from earlier versions of Preview, which also deleted useful
metadata like a PDF’s table of contents.
Exporting to PDF: Encryption — Preview’s Encrypt checkbox may be more use-

Washington Apple Pi Journal
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reduce the chances that it will be read more widely by encrypting the document,
after which a password is necessary to display it.
In PDF parlance, the password created by Preview’s Encrypt checkbox is a “document open” or “user” password, as opposed to a “permissions” or “owner” password, which restricts editing and printing of the document. More on how to set a
permissions password in a moment; you can’t do it from the Export dialog.
Preview offers no facility for entering the permissions password to override previously set restrictions, with one exception. If you open a PDF encrypted with a
permissions password that prevents changes, and then try to use Preview’s File

Figure 5.

> Export or Export as PDF commands, you’ll be prompted for the permissions
password. That is, unfortunately, false security because any change in a permis-

word, and thus can’t do anything for you that you can’t accomplish more effi-

sions-protected PDF causes Preview to make a copy that you can save. Plus, while

ciently in Preview itself.

Export may ask for a password, File > Save As does not. Oops.
What if you want to remove a document open password from an encrypted
To encrypt a PDF with a document open password, choose File > Export, select the

PDF? As long as you know the password, it’s simple — just open the PDF, enter

Encrypt checkbox, enter a password, and then enter the password again to con-

the password, and then use Export to save it again, without selecting the Encrypt

firm it. From then on, when anyone — including you — tries to open the encrypt-

checkbox. This technique might be useful if a document was confidential for a

ed PDF, in any PDF-savvy app, they’ll be prompted for the password (Figure 5).

time, but no longer needs to be.

As far as we’re aware, as long as the document open password is relatively

Printing to PDF: More Encryption — As previously mentioned, you can “print”

strong, there’s no way to brute force it. (If you use a weak password, a diction-

any document from any app to a PDF. This is a system-wide feature in OS X,

ary attack may be able to crack it.) You may run across utilities or Internet ser-

thanks to Quartz’s foundations in PDF, and is tremendously useful for testing

vices like PDFUnlock [35] that claim to be able to remove passwords from PDFs.

what a print job will look like before sending it to your printer or for saving a Web

They’re talking about the permissions password, not the document open pass-

page as a PDF.
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Figure 7.

Figure 6.

But why print to a PDF from Preview, which has built-in PDF export capabilities?

that menu, you may see a bunch of printing workflows that various apps install

For one thing, it offers more metadata and security options than Preview’s ex-

for you. They make it easy, for instance, to print a document to PDF and send it

port feature, but it also solves a common Preview problem.

with Messages in one step.) See Figure 6.

Since we began this series, several readers have written in with the same issue:

In the Save dialog that appears next, you’ll notice a few additional options. You

you mark up a document in Preview, save it, send it to a collaborator, and they

can enter not just the filename, but also title, author, subject, and keyword meta-

don’t see your annotations. We don’t know why this might happen — PDF is a

data. This standard PDF metadata becomes visible in Preview’s Inspector window

standard, but that doesn’t mean every app implements it correctly — but print-

(choose Tools > Show Inspector or press Command-I), in other PDF apps, and

ing to PDF appears to cause the annotations to show up properly in most cases.

even in the Finder’s Get Info dialog (Figure 7). But there’s more! Click Security
Options, and you can set both the document open and the permissions pass-

To export a PDF in this way, choose File > Print. In the resulting dialog, click the

words for the PDF, and choose whether the permissions password will restrict

PDF pop-up menu in the lower left and choose Save as PDF. (Further down in

changes, printing, or both.
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Preview in the Rearview Mirror — This article wraps up our series on Preview. We

[19]: https://en.wikipedia.org/wiki/OpenEXR

hope you’ve enjoyed it, and if you have more questions about Preview or tips to

[20]: https://en.wikipedia.org/wiki/Netpbm_format

share, let us know. Who knows what additional features might lurk within Pre-

[21]: https://en.wikipedia.org/wiki/PVRTC

view’s depths?

[22]: https://en.wikipedia.org/wiki/Adobe_Photoshop#File_format
[23]: https://en.wikipedia.org/wiki/PostScript

Finally, although we don’t have a schedule set yet, the response to this series has

[24]: https://en.wikipedia.org/wiki/QuickTime_File_Format

been so positive that we’re planning to start on a “Take Control of Preview” book.

[25]: https://en.wikipedia.org/wiki/Silicon_Graphics_Image
[26]: https://en.wikipedia.org/wiki/Truevision_TGA

[1]: http://tidbits.com/article/16284

[27]: https://www.lemkesoft.de/en/products/graphicconverter/

[2]: http://tidbits.com/article/16423

[28]: http://www.amazon.com/dp/0596006551/?tag=tidbitselectro00

[3]: http://tidbits.com/article/13187

[29]: http://www.amazon.com/dp/1449327915/?tag=tidbitselectro00

[4]: http://tidbits.com/article/16114

[30]: http://www.amazon.com/dp/1449310028/?tag=tidbitselectro00

[5]: https://en.wikipedia.org/wiki/Graphics_Interchange_Format

[31]: http://tidbits.com/resources/2016-05/Preview-sepia.png

[6]: http://bits.blogs.nytimes.com/2013/05/23/battle-over-gif-pronunciation-erupts/?_r=0

[32]: http://tidbits.com/resources/2016-05/Preview-lightness-comparison.png

[7]: http://en.wikipedia.org/wiki/JPEG?r=0

[33]: http://tidbits.com/resources/2016-05/Preview-reduced-size.png

[8]: https://en.wikipedia.org/wiki/JPEG_2000

[34]: http://tidbits.com/resources/2016-05/Preview-unlock-PDF.png

[9]: https://en.wikipedia.org/wiki/Portable_Network_Graphics

[35]: http://www.pdfunlock.com/

[10]: http://tidbits.com/resources/2016-05/Preview-PNG-vs-JPEG.png

[36]: http://tidbits.com/resources/2016-05/Preview-Print-dialog.png

[11]: http://tidbits.com/article/16423

[37]: http://tidbits.com/resources/2016-05/Preview-PDF-print-options.png

[12]: https://en.wikipedia.org/wiki/Tagged_Image_File_Format

[38]: http://tidbits.com/resources/2016-05/Preview-Print-to-PDF-security.png

[13]: https://en.wikipedia.org/wiki/Adaptive_Scalable_Texture_Compression
[14]: https://en.wikipedia.org/wiki/Apple_Icon_Image_format
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Responses to General Meeting Questions, May 31, 2014
Editor’s Note: Two years ago, we asked Pi members

would later add the food values to the pictures. The

originally and vice versa?

to respond to a series of questions regarding their

doctor could then see what was missing or needed

I still have an old Power Mac, not even with the Intel

introduction to Apple devices, and their subsequent

in their diet.

processor. When we bought this one, I was told the
Intel processor was not yet good with graphics (It

experiences with them. Here are some responses we
received. They are presented here as submitted by the

This computer was so small. (Maybe a ten-inch

had just come out.) So we decided to stay with the

responders.

screen?) Everything was bit-mapped. I did many

Power Mac. I do very little graphics on it. I have a

pages of foods. It was like magic to be able to draw

scanner, so I prefer to draw or paint “in real life.” I use

Helen Barsalou

with a mouse. I really enjoyed it. When I retired from

it mostly for contacts with the several art groups I

Were you one of the first Apple users, an early Mac

the company in 1987 and started painting, mostly

belong to. I also taught watercolor for 18 years, so it

enthusiast, or a later switcher from the PC side? Why

watercolors, I decided to have a show and sell my

was a good tool for that.

did you buy your first Apple product?

work. I needed a mailing list for invitations. My hus-

In 1985 or ‘86 I was still working full time as the art

band knew a little about computers from his work,

What device have you purchased most recently?

director for JWK International, one of the “Beltway

so we bought our first Mac.

My husband has an iPad and loves it.

None of the other offices had one. No computers at

What made you stick with Apple products through

Which one is most essential to your life? How can

all! Just typewriters.

the days when doom was predicted, or convinced

the Pi help you to get the most out of your Apple

you that the company would survive and flourish

technologies?

She had a contract to develop a program of ques-

and deserve your cash? How many devices have you

I’m not sure. Some day we will probably buy a new

tions that patients could answer in a doctor’s office.

owned?

one.

It involved things like, “Which of these foods have

As far as I knew, it was the only computer that had a

you eaten this week?” She asked me to draw pic-

graphics capability.

Bandits.” One of the vice presidents bought a Mac.

Finally, what new Apple device would you be most
likely to buy, should they develop it?

on one page of a similar food, like eight different

How has your use of Apple products evolved over the

fruits, eight different meats, etc. Then a nutritionist

years? What are you doing now that you didn’t do

Washington Apple Pi Journal
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Jimmy Nalley

That fact that I could create documents in Mac-

almost thirty years. They just work. If I see a use

My first computer was a Macintosh 128K that had

Write or MS Word 1.0, make databases in MS File

for a new product class from Apple, I will be a re-

been upgraded to 512K. I purchased it in July of

1.0, communicate on Compuserve, or do a spread-

vision 2.0 adopter.

1985 from Raoul at MacCorner in Gaithersburg, MD.

sheet in MS Excel 1.0 was an incredible bonus that

I came to find out that he had purchased a large

opened a whole new and time-consuming world

I have consistently used Macs in my recording

number of the 128K’s from the government and pro-

for me. My dad and I were amazed by moving the

studio then and now. However my other uses of

ceeded to upgrade them and sell them as new for

mouse in MacPaint and drawing on the screen. We

Apple products have changed greatly over the

$2,000.00 with a full warranty. I don’t know if mine

had seen this in a futuristic exhibit at the IBM pa-

years. I ran my resort property management com-

was used or not, but I was completely excited by

vilion of the Seattle World’s Fair in the early 1960’s.

pany from 1985 to 1995 with a Mac Plus. Reserva-

my first computer. I had been wanting one for quite

It only took another twenty-plus years to become

tions and maintenance schedules for short-term

a long time. I just wasn’t ready to learn line com-

a mainstream reality.

vacation rentals were done in Excel, inventories in
MS File, brochures designed with Photoshop and

mands.
Back then the Apple Pi helped take me from new-

Quark and/or Pagemaker. I’m still using the mail

I WAS “The Rest of Us.” I wasn’t a programmer or

bie to an educated and fairly proficient Mac user.

merge capability of Clarisworks 5.0 on an old Snow

computer engineer. I was a musician, and I simply

I was thankful for the Tuesday night beginner

Globe Mac running MacOS 9.2 to generate letters,

wanted a machine that would store the sounds and

tutorials. I’m sure they went a long way to evange-

contracts and a customer database for my cur-

sequences and samples made on my new Kurzweil

lize for and establish a strong base of Macintosh

rent DJ/Karaoke Allstar business (1993 to present).

K250 digital keyboard. The owners’ manual dictated

users. I became a Mac “Fan-Boy.” I never veered

I actually DJ from a combination of iTunes on my

that the only computer capable of storing the in-

from my Macs even during the worst of times for

eleven-inch MacBook Air and my iPhone 5s us-

formation generated by my Kurzweil was the new

Apple, though technically I did veer a little when I

ing Beats. Needless to say the iPhone and the App

Macintosh. So...on top of my $11,000 keyboard I had

purchased a Mac clone from Power Computing in

Store and iOS have opened limitless possibilities

to purchase a $2,000 computer, $1,500 Bernoulli Box

1997. I’ve owned eight different desktop Macs, one

in mobile computing and communications that I

(5-MegaByte cartridges), a $300 300 Baud modem,

laptop, one iPod, two iPhones, one iPad, and an

never dreamed of when I purchased my first Apple

and assorted software. Thus began almost thirty

assortment of scanners, printers and other periph-

Macintosh computer way back in 1985.

years with a heading in my budget labeled “Apple.”

erals. Apple’s attention to quality and detail have
made my choice of computer a «no-brainer» for
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Herbert Rust

became a University of Maryland standard.

8. I fear the App store may be more and more

My first venture into computing was pre Apple his-

2. I got an early Intel Mac Mini to try it out. I was

problematic, with “sandbox” restrictions.

tory and was a large laptop, which I used for my of-

hooked by a label program called Imprint (which

9. Cloud confidentiality and security are a growing

fice accounting and continued to use solely for that

is out of business but I still use it at least weekly)

concern.

purpose. I did not use it for anything else because

and then by DEVONthink. There are no Windows

10. I don’t use social media, including Facebook,

the Microsoft operating system was a nightmare of

equivalents for either one, but no Mac program to

Twitter, Linked In. Perhaps if I were exposed to Ap-

inoperability. So then came the first Mac; I got that,

replace Imprint, either. DEVONthink is essential for

ple Pi tutorials on these, I might engage.

and really that was my first actual “computing.” Like

my work, and Imprint is very handy.

11. Beltway traffic makes attendance at Apple Pi

many of us, I have never left Mac, never doubted

3. I run CrossOver so I can use three or four Win-

meetings in Virginia a real challenge. The trip is

their ability or future. As some of you might know,

dows programs without buying Windows. I did try

long and often feels dangerous so I don’t come as

many years ago, long before the iPad, Steve did a

Parallels a long time ago, but it was never smooth.

often as I used to when they were in Maryland.

film of his “device of the future.” It was basically a

4. I have a 2012 Mac Mini 2.6GHz w/ 16 GB

Pad, with capabilities far beyond what even the new

memory, and an Amazon Basics DVD drive.

iPads offer, so I kind of already knew where we are

5. Mavericks is somewhat sluggish compared with

heading.

Windows 8 on my HP laptop. Each new Mac OS

Our family started with the Apple II to introduce our

seems more bulky than the one before. It got very

kids to computing while they were young. We had

I currently have a MacBook Air, an iPad Air and a new

slow with Mavericks, but was greatly improved af-

them learn how to keyboard before we “discovered”

iPhone 5S. Love them all and eagerly look forward to

ter a complete re-installation via the App Store (an

that there were some games in the package. I, per-

the future of Apple for us all. By the way, it’s not just

easy but lengthy process). Many Apple Pi members

sonally, never liked the somewhat awkward Apple II.

for youngsters. I just had my eighty-second birthday

could benefit from this procedure, and I posted

and am looking forward to setting up a new health-

this advice in two places, but I don’t know if the

The conversion occurred when I joined a bunch of Pi

care website and blog.

word ever got out.

enthusiasts at the East Coast introduction of the Mac

6. I have an iPod Touch and, most recently, an

at what was then called the Departmental Audito-

Art Milholland

iPad Air, which I use very little so far.

rium on Constitution Avenue. The Apple technicians

Re the questions you pose, let me say briefly:

7. I don’t think I have need of any particular future

sold me immediately with their presentation of a

1. I had an Apple II years ago to try out, but PC’s

product.

visually oriented operating system. We joined in the
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group purchase from a company in Pennsylvania. I

I am curious to see what Apple will do with the TV

great for word processing and Sun Microsystems ap-

have had several versions of the Mac since.

interface.

peared to be a Mac on steroids.

I thought the company would continue to serve a

John DiBella

Linda

niche market because of its competence and qual-

What made you stick with Apple products through

I bought my first Mac in 1984 and carried it to work

ity, even while losing market share. We have had

the days when doom was predicted, or convinced

every day. Then I bought a used Lisa (which I donat-

several versions, but my favorite was the silent Cube.

you that the company would survive and flourish

ed to the Pi years later). In Oct. 1987 I made my best

The tiny box contained the same computing power

and deserve your cash? How many devices have you

purchase - 100 shares of Apple stock.

as the original Cray 1 supercomputer. If it was good

owned?

enough to be on the desk of Steve Jobs, it was good

I already owned three Apple computers (Apple II+,

When Apple announced a laptop, there was tre-

enough for me.

Mac Classic, and the MAC Quadra 610), plus I had the

mendous interest where I worked. We asked Apple

software and didn’t want to spend any more money

to send someone with one to show us. We had over

on another system.

200 attending, but Apple sent the worst speaker

I am not a power user. Mostly I use the Mac for
e-mail, writing, and searches. The only program I

possible, who told us about it instead of showing,

miss from the first Mac is MacDraw. It was a won-

During the hard times in the early to mid-1990s, I

derfully simplistic program, which I incorporated in

attended almost every monthly WAP meeting. So I

my newsletter at the time. The newer programs are

guess having a good local support group made me

more sophisticated than I need. The biggest thing I

feel that the Apple product line would eventually

miss are the manuals. When Apple published them,

improve and maybe overcome its business manage-

Kevin W. Parker

they were the best manuals in the world for any

ment problems.

My first Apple—and my first personal computer—

and the IBM/MS types dominated for years later.

products. The texts were great and the illustrations

I am now retired and out of the area.

was a “Fat Mac,” with a whopping 512k of memory,

were of superb quality. Daily, I use an iMac with a

I used many different computer systems, test equip-

that I bought in 1985 with a paycheck-secured loan

big screen. The most recent purchase was an iPad,

ment and various electronic devices in my work. I

from the company I worked for at the time. I went

which I mostly use when traveling. The Pi has contin-

feel that HP, Tektronix, and Fluke made the best lab

with the Mac over the alternatives because I was a

ued to inform me about potential computer applica-

equipment. And I feel the IBM Mainframes and Ap-

computer programmer by day and was tired of try-

tions, even if I don’t use them personally.

ple made the best computers, although Wang was

ing to keep straight all the different command line
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interfaces I had to deal with. I wanted something

run on my first-generation one. I’m planning on do-

it in 2011 with a more current version.

ing that as soon as they come out with the next ver-

more intuitive, plus I figured my wife would be less
intimidated by a Mac.

Before then, though, I bought an iPad, uncharacter-

sion. (I was hoping the rumors of an upgrade in April

istically being an early adopter (at least by my stan-

would come to pass, but alas they didn’t.)

I upgraded it several times, first to a 512kE (I think

dards), buying it in June of 2010. It was a huge hit

that’s the term) and then to a Mac Plus. I’ve still got

at my high school reunion. For one thing, the band

My laptop is definitely the one device I’d want to

it in storage somewhere. Maybe some museum will

at the evening’s festivities was asked to play a song

rescue in a fire. I use it for financial management,

want it someday....

they didn’t have the sheet music for. I was able to

emails, getting online generally, managing photos,

find it online and let them read it off the iPad.

writing, playing games, and so on. The iPad is more
of a backup, and the Air is mostly for getting by

Circa 1994 I upgraded to a PowerMac 6100, which
stood me in good stead for some years. I don’t recall

What else? My wife and I have both had iPods for

when I’m away from home; I haven’t really kitted it

ever worrying about Apple going out of business, so

ages. Hers is a Classic, mine is a 2006-era Nano. The

out to be fully functional.

that never concerned me.

old iMac got too slow, so several years ago I got her
a new one. And last year I decided that I didn’t like

Other than the changes that came with the Inter-

A couple of years into the new millennium, with

traveling with my main laptop with so much of our

net, there haven’t been too many changes to my

Apple on the rebound, I bought one of the first flat-

personal information on it, so I got a MacBook Air

behavior when it comes to computers. Even then I

panel iMacs. That and the upgrade to OS X were

that I think is amazing. I think I actually prefer it por-

can remember getting online to BBS’s decades ago,

both interesting experiences, and I believe I wrote

tability-wise to the iPad.

followed by GEnie, followed by AOL, followed by
the World Wide Web (thanks to WAP’s TCS Explorer

an article for the WAP Journal about it.
Oh, I almost forgot the Mac Mini that’s the heart of

service) in all its glorious variety. Other than that, I’ve

In 2004, I suffered a blood clot in my leg, and it

our relatively bare-bones entertainment system. We

always used them for finances, writing, and game-

became painful to sit for very long without my leg

mostly use it as a glorified DVR, using a software

playing.

propped up. So in 2006 I bought a MacBook Pro that

package to record programs to view later.
I can’t think of any possible new Apple device I’d like

I could prop up in bed with, and my wife inherited
the iMac. (I think I wrote an article about that, too.)

My next major Apple purchase will definitely be a

to have. I’d just like to have current ones be a little

That worked well until the laptop died, so I replaced

new iPad as there are just too many apps that won’t

bit smarter. For example, it shouldn’t be necessary
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for me to reload my online comics every day. My

Originally I could turn it on. Then I became a pow-

models were available at the time. We needed a lot

iPad should be smart enough to realize that I want

er user, could trouble-shoot extension conflicts,

of help with those, one a dot matrix, and one a daisy

that EVERY DAY and just do it.

learned to swap out hard drives and ram, reinstall

wheel.

the OS, and got a job in tech support. But now I have

Martha Lufkin

an Air; nothing I can replace in this one! Most recent

We graduated from those to a IIx, I think—one of

Were you one of the first Apple users, an early Mac

device is the iPhone 5c. I use my Air and iPhone daily

the beige boxes—a clamshell iBook, and a blue G3

enthusiast, or a later switcher from the PC side? Why

but I think the laptop is the more essential of the

iMac. Since then we’ve had a succession of iMacs,

did you buy your first Apple product?

two. I love hearing about new software (and apps

hers now a 21-inch 2010 model, and mine a 27-inch

I bought my first computer in 1986, the Mac Plus.

for the phone). Maybe someday the phone will be-

2013 model. Ann still laughs about her “$1000 type-

My husband had used a Mac at his previous job and

come more essential.

writer”, since word processing is most of her work,
but that disguises the fact that she has put together

missed having one.
Finally, what new Apple device would you be most

four websites and a blog. And we’ve never even con-

What made you stick with Apple products through

likely to buy, should they develop it?

sidered PC’s, although we both learned to use them

the days when doom was predicted, or convinced

A lighter-weight phone would be ideal. And after

in our jobs. In fact, the irritations we encountered

you that the company would survive and flourish

owning a smart phone for six months, I realize 8GB

when working on PC’s were what convinced us to

and deserve your cash? How many devices have you

isn’t nearly enough.

stick with Apple no matter what.

It was a good product and met my needs; it never

Jim Utterback

My history takes up when I inherited her IIC, which

occurred to me to change. I can recall sixteen devices.

We purchased our first Mac in 1984, a IIC. My wife,

I used mostly for bills and simple accounting re-

Ann, was writing a book and needed a word proces-

cords. However, when I moved into a training po-

How has your use of Apple products evolved over the

sor to do it efficiently. She was able to teach herself

sition, I needed to get up to speed on photo and

years? What are you doing now that you didn’t do

how to use the computer without previous knowl-

video processing as well as advanced MS Office

originally—and vice versa? What device have you

edge and has used Macs ever since. By the time we

functions. Since the office I worked out of was all

purchased most recently? Which one is most essen-

were done with that particular machine, it had an

PC, I learned that platform as well, but the Macs

tial to your life? How can the Pi help you to get the

external floppy drive, two printers, and added RAM.

made it easier to teach myself the skills I needed

most out of your Apple technologies?

The toughest thing was the printers, since not many

and to create agnostic materials that anyone could

owned?
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use. And when I started, there was no other user-

iPads daily for most of our communication and read-

friendly video application but iMovie, so I persuad-

ing. It’s especially important to Ann, who had one

ed my trustees to purchase Macs: a PowerMac G4

from the first day, since she has vision problems and

and a G3 iBook. Eventually I moved on to Minis,

a chronic disease that prevents her from sitting at a

and then to the iMac when I retired.

desk for very long. She reads now almost exclusively
on the iPad using Kindle.

Early on, we employed a consultant we found at a
computer store, who assisted us when we got stuck

As for the future, I’m not sure what new device we

somewhere, and eventually I picked up a lot of his

would consider. We may well be on our last desk-

skills. That’s how I found the Pi, and have used its

tops. We’ll definitely upgrade our iPads as needed,

services at the clinics, through the Journal, and in

but smaller handheld devices are pretty much out

the online forums. So I’m the family geek, and I vol-

of the question, because of the screen size. We have

unteer as a tutor each week for anyone in our retire-

an Apple TV, which is great, and we would upgrade

ment community who needs help with Apple ma-

that if a better model comes out, especially if there

chines. I’m a huge fan of the Journal and the online

were some kind of DVR included.

community. They’re worth the annual subscription
easily.
We have owned seven Macs, and now two iPads
and an iPhone. We are both on our second iPad, and
we’ve also owned two iPod Touches. In my business, my home office had a total of five Macs over
the years, including two laptops. My 27-inch iMac is
still essential to my life, both for its larger screen as
my eyesight gets fuzzier, and because I still do a lot
of photo and video processing. But we both use our
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Pi Comic
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Volunteer Opportunities

Members
Helping Members

Featured Position – General Meeting Webcast Director

Dedicated volunteers are the lifeblood of the Pi.

not attend the meetings. Using the same camera, we are able to concurrently produce live webcasts so

Whether it is installing a hard drive at a Clubhouse

members can view the meeting in real time via the Internet. We need a dedicated volunteer to oversee

Saturday event, answering questions at a General

the technical and production aspects of this webcast.

The Pi currently captures its General Meetings on videotape for future viewing by members who can-

Meeting, or placing advice on the TCS Forums, there
are many ways to pitch in and help, depending on

There are various technical components to putting up the video on the Pi’s Ustream web page.

a member’s interests and talents. Please consider

The Webcast Director needs to ensure that the equipment is properly set up and functioning, and needs

making a commitment to ensure that the Pi remains

to monitor the audio and video streaming production from start to finish (or designate someone to do

a strong and energetic club dedicated to helping

this) to ensure satisfactory audio and video quality. The Webcast Director will not be responsible for any

its members. All volunteer efforts are appreciated.

other part of the General Meeting program, but will focus exclusively on the webcast production.

Check out these areas where assistance is needed.
Any previous experience in TV or video production would be advantageous, but is not required. A basic
understanding of video and audio equipment and how to connect them would be helpful, but the contracted cameraman has primary responsibility for equipment hookup. The Webcast Director needs to
make sure that the meeting presenters do not stray from their predetermined stage positions, so they
remain adequately illuminated for the entire presentation. Also, this person should be available in case of
a technical or other problem that would require the speaker to temporarily suspend their presentation.
Case in point: the Webcast Director will stop the action when the cameraman indicates that a new tape
needs to be swapped out in the video camera.
If you are interested in helping out with an eye on taking over this important position, contact
office@wap.org.
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Journal Managing Editor
The Journal is an established, time-honored publication of the
Washington Apple Pi and it is in need of someone to take over
as Managing Editor, leading a team of dedicated and highly
skilled volunteers. The Journal schedule calls for bi-monthly
publications, and most of the activity occurs in the three
weeks leading up to the publication date. In addition, this
person will be a member of the Pi’s Publications Committee,
which has oversight of all printed material published by the Pi.
The job is challenging, but very rewarding.
If you enjoy writing and want to help the Pi progress, this is

General Meeting Manager
Our General Meeting programs need someone dedicated to the planning and managing of these important club events. The job includes coordinating meeting activities, making any necessary arrangements, and managing the behind-the-scenes tasks. While it sounds like a job for Superman, that really

the job for you. If you enjoy working with enthusiastic col-

is not the case. If you have juggled household duties or been an office administrator, you have the

leagues on meaningful projects, apply today.

skills. While another Pi manager emcees the meeting, you will be making him or her look good!

Contact the interim Journal editor, Jay Castillo, at:

Because this activity needs to be approved by the Pi’s Management Committee, the volunteer will serve

editor@wap.org with any questions or to express

as an adjunct member of that committee. This volunteer opportunity is guaranteed to keep you busy, and

your interest.

when the meeting is over and everything is packed up, lunch is on the Pi.
Send your inquires to office@wap.org to express interest and we’ll go from there.
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